
SEE TWICE AS MUCH COSEE TWICE AS MUCH CONTENTNTENT  
In Outlook 2003, you can change the 

position of the preview pane from the familiar 
view at the bottom of the screen to an “out of 
the way” view on the right side of the screen. 
This allows twice as much of your e-mail content 
to appear on the screen making reading your  
e-mail easier than ever. 

FOLLOW LONG EFOLLOW LONG E--MAIL TMAIL THREADSHREADS  
You won’t lose the thread in Outlook 

2003  because this messaging client can display 
them in a compressed, non-cluttered form that 
makes conversations easier to follow and the 
Inbox appear less crowded. Threads can also be 
managed as a block of text rather than 
individually through multiple steps. 

NAVIGATE WITH CONFIDENCENAVIGATE WITH CONFIDENCE  
Working in Outlook 2003 is easier than 

ever with the new Outlook Navigation Bar. This  
navigation reference allows you to easily 
transition from e-mail to tasks to frequently 
used activities. Search Folders are a special 
feature within the Outlook Navigation Bar that 
you can learn more about on Page 3. 

Cached Exchange Mode virtually eliminates the familiar 
"hung" state that users may have experienced with previous 

versions of Outlook if there were difficulties contacting the Microsoft 
Exchange Server. When configured for Cached Exchange Mode 
Outlook 2003 can insulate you from changing network conditions by 
working against a locally cached mailbox that is kept up to date with 
the server mailbox. Cached Exchange Mode is activated by enabling the 
“Use cached Exchange mode” option located in E-mail Accounts in the 
Tools menu. 
Note: Cached Exchange Mode is only available if your organization uses 
Microsoft Exchange Server. Consult your e-mail administrator to see if 
this option is available. 

CACHED EXCHANGE MODE 
Cached Exchange Mode always knows the status of the connection to 
the Exchange server to determine online/offline status. Using 
Outlook 2003 with “Use cached Exchange mode” enabled provides a 
better user experience when a network connection to the Microsoft 
Exchange Server is slow or unavailable. By providing different levels of 
optimization, Outlook 2003 automatically detects and adapts to 
changing connection environments, such as disconnecting from a 
corporate LAN, going offline, and then re-establishing a connection to 
the server via a dial-up connection. 

 

 

 
 
 
 
 
 
 
 
 
 

AUTOMATIC SYNCHRONIZATION WITH EXCHANGE SERVER 
Rather than continually polling the Exchange Server for changes, 
Outlook 2003 relies on server-to-client notifications to determine when 
there are changes on the server that need to be downloaded. You no 
longer need to use F9 or shift+F9 to ensure your local mailbox is up to 
date. When operating in cached Exchange mode, the notification 
process ensures that your local mailbox is always up to date.   

BENEFITS OF CACHED EXCHANGE MODE  
In cached Exchange mode users work from a local copy of the mailbox 
called the Offline Folder file (OST) file. Simultaneously, in the 
background, Outlook 2003 synchronizes data from the Exchange Server 
to the local copy of the mailbox. 

More reasons to take advantage of cached Exchange mode include: 

• Take advantage of Outlook’s new Junk E-mail filtering while running 
in cached Exchange mode. 

• E-mail is stored both locally and on the Exchange Server mailbox 
store.  

• Accidentally deleted e-mails can be recovered from the OST; e-mail 
deleted from a PST cannot be recovered. 
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Inside This Messaging Guide 

DO MORE FROM YOUR DESKTOP WITH OUTLOOK 2003! DO MORE FROM YOUR DESKTOP WITH OUTLOOK 2003!   
Welcome to the Microsoft® Messaging Quick Reference Guide. This guide shows how the new and improved features in Microsoft Office Outlook® 

2003 and Microsoft Exchange® Server 2003 can be used to help you work more efficiently and effectively. After reading this guide you will be 
able to use Search Folders, Quick Flags, and Rules to help manage and organize your e-mail. You’ll be able to create secure and customizable 
collaboration environments in Meeting and Document Workspaces, send faxes from your desktop, work in cached Exchange mode, and connect from a 
remote location using Mobile Messaging. You will learn about messaging security options, trustworthy messaging, managing un-solicited e-mail (spam), 
and other useful messaging service developments. We hope you find the information in this guide helpful and will keep it handy for future reference. 



SEARCH FOLDERS OVERVIEW 
Search Folders in Outlook 2003 help users spend less time finding e-mail 
messages. Search Folders are live search results that look and act like 
folders, but differ from traditional e-mail folders in that e-mail is not 
saved in them. They are virtual folders that contain views of all e-mail 
items matching specific search criteria. Search Folders can be quickly 
set up with a number of pre-designed options, such as e-mail flagged 
“For Follow Up” or “Unread Mail.” You can also create your own custom 
Search Folders, defining specific search criteria that an e-mail must 
meet to be displayed in the folder.  

USING SEARCH FOLDERS 
Three Search Folders are created by default: 

For Follow Up: This folder provides a virtual 
to-do list of all Quick Flagged messages. 

Large Mail: This folder assists with mailbox 
cleanup by showing the largest e-mail 
messages from across the entire mailbox. 

Unread Mail: All of a user’s unread e-mail messages on the server 
regardless of their folder, are shown in the Unread Mail search folder. 

CREATING A NEW SEARCH FOLDER 
1. Under File, select New, Search Folder.  
2. Select the type of Search Folder you want in the New Search 

Folder dialog. 
3. Select Custom Search Folder. 
4. Click OK and follow on-screen instructions. 

CUSTOMIZING SEARCH FOLDER SEARCHES 
By default a Search Folder will search through all of the folders in your 
entire mailbox including sent and deleted items.  To customize the 

search: 

1. Right click on a Search Folder and select      
Customize this Search Folder. 

2. Click the Browse button. The Select Folder(s) 
dialog will appear. 

3. Click the Clear All button. 
4. Select the folders to be searched and click OK. 
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Security is of the highest importance for most 
organizations and utilizing secure e-mail  
(S/MIME) and Microsoft Information Rights 
Management (IRM) are great ways to make your 
e-mail more trustworthy. The following 
guidelines should help you decide when to use 
each of these technologies.  

When to use IRM to Protect Content: You 
should use IRM in all Office 2003 products if you 
want to control who can access your content and 
also control what those people can do with that 
content. IRM should meet most of your internal 
trustworthy messaging needs. See the 
accompanying section titled Information Rights 
Management for more information about IRM. 

When to use S/MIME to Digitally Sign E-mail: 
You should digitally sign e-mail if you need to 
prove to your recipients that you are who you 
say you are and that the content was not 
tampered with in transit. S/MIME signing will not 
prevent unauthorized people from viewing the 
content.  

When to use S/MIME to Encrypt E-mail: Like 
IRM, you should use S/MIME to encrypt e-mail if 
you want to control who can access your e-mail 
content, but you also want to force the 
recipients to enter a password to further 
validate their credentials.  
 
E-MAIL SIZE IMPACT USING S/MIME AND IRM 
It is important to realize that S/MIME and IRM 
result in an increase to the size of the e-mail 
you are sending.  

Note: The size increase with IRM varies, but is 
generally smaller than with S/MIME. Due to 
the impact of file size, it is recommended 
that you do not use S/MIME and/or IRM on all 
e-mail by default. Instead, choose when to use 
these technologies where they make the most 
sense for your specific business e-mail needs. 

Use the numbers in the table as a guideline.  

IRM is an exciting feature in Office 2003 that 
allows you to control the distribution and usage 
of documents and e-mail. IRM spans Word, 
Excel, PowerPoint®, and Outlook 2003 and 
helps to meet the following scenarios:   

• Write an e-mail that cannot be forwarded 

• Collaborate on time-sensitive information 
that will become inaccessible after a 
certain time. 

• Create documents and e-mail marked 
“Confidential” that stay inside your 
organization and are inaccessible to 
unauthorized users. 

WHY USE IRM 
Using IRM on documents and e-mail means you 
can control their distribution and usage. This 
means that information marked “Do Not 
Forward” won’t be, unless the user is 
intentionally and maliciously trying to 
redistribute your content to others.  

Note: IRM will not stop users from taking 
screenshots via non-Microsoft products or 
photographs of content. 

You can use IRM on any type of information. If 
you are writing a document or e-mail and think 

“I wish there was a way I could control where 
this information goes,” then IRM is appropriate. 
Note: Any user with Microsoft Office 2003 or 
the Microsoft Rights Management Add-in (RMA) 
for Microsoft Internet Explorer 6.0 will be able 
to view the IRM-protected material you send to 
them.   

KEY FEATURES OF IRM INCLUDE 
"Do Not Forward" E-mail: Create protected  
e-mail messages that prevent recipients from 
forwarding, printing, or copying information. 

Document Permission: Create Word 2003, Excel 
2003, and PowerPoint 2003 documents that only 
designated users can read, preventing them from 
extracting your information and/or repurposing 
it without your permission. 

Information Expiration: Specify how long your 
information is accessible. After the expiration 
date you set has passed, users will no longer be 
able to view the protected information. 

Protect From Prying Eyes: IRM uses strong 
encryption to help ensure that people without 
permission cannot get access. 

HOW TO USE IRM 
To apply IRM permissions, click the circular red 
button located in each Office application 
toolbar.  

Type Normal S/MIME IRM 

RTF 1 line 3K 7K 12K 

RTF 1 page 4K 15K 15K 

RTF 10 pages 12K 94K 53K 

HTML 1 line 3K 7K 7K 

HTML 1 page 9K 15K 15K 

HTML 10 pages 57K 86K 42K 

Information Rights Management 



CREATE CUSTOM RULES FROM SCRATCH OR 
USING TEMPLATES 

Custom Outlook rules save time and makes e-mail   
organization much simpler by automatically performing 
many actions based on the criteria you establish. 
1. Click on the Inbox folder. 
2. Select Rules and Alerts... from the Tools menu. 
3. Click on New Rule… to launch the Rules Wizard. 

• If you want to use a template with pre-specified 
actions and conditions, Click Start creating a rule 
from a template. 

• If you want to use custom conditions and actions, 
Click Start from a blank rule. 

4. Follow the instructions in the Rules Wizard. 
5. If you want to run the newly created rule on 

messages already in the Inbox, select the Run this 
rule now on messages already in Inbox check box 
on the last page of the Rules Wizard. 

6. (Optional) If you have more than one e-mail 
account or Inbox you can have this rule apply to all 

of them. Select the “Create this 
rule on all accounts” check box on 
the last page of the Rules Wizard. 
 
 

Composing and Sending a Fax 

With Microsoft Office 2003, 
faxing is now as easy as sending an  
e-mail message if you have the 
contents accessible electronically. 
Here are the steps to send a fax with 
any Office application, including 
Word, Excel, and PowerPoint 2003: 

1. Click on the File menu, point to 
Send To, and then click Recipient 
using Internet Fax Service. 

2. Complete the Fax Recipient, Fax 
Number (for international faxing, 
do not enter leading zeros before 
a city code), and Subject fields. 

3. From the Fax Service task pane on 
the right, choose from the cover 
sheet options available, and then 
complete your cover sheet located 
in the body of your e-mail message. 

4. The fax document will be an     
attachment. Additional documents 
can be added by either clicking on 
the Attach… field or by clicking on 
the paper clip icon from the 
Toolbar. Click Send. 

Faxing from Outlook is very similar: 
1. Open a blank e-mail  
2. From the File menu choose Send To 

and then Recipient using Internet 
Fax Service…  

3. The Fax Service pane will appear 
on the right and the send fields will 
change to picture shown in step two 
above.  

The body of the e-mail is the cover 
page and attachments can be added as 
in step four above.  

OVERVIEW 

Outlook 2003 makes it possible to view 
multiple calendars including local, public 

folder, other users’ calendars and calendar views 
side-by-side in the Outlook window. The calendars 
scroll together and are color-coded, making them 
useful for comparing schedules. Users can drag 
appointments between calendars or onto their own 
calendar or use the New Meeting With feature to  
quickly set up a meeting with the owners of some 
or all of the open calendars.  

Note: This feature requires network connectivity 
to an Exchange Server and is not available while 
working Offline. 

VIEW MULTIPLE CALENDARS SIDE-BY-SIDE 
When you click on the Open Shared Calendar 
hyperlink, a dialog box will appear that specifies 
which contact’s calendar you would like to open. 

Selected calendars will be listed along side of your 
calendar for easy viewing. This provides a view of 
schedules and available times for meetings. 

This feature requires viewing permissions to be set 
on each calendar you wish to view. Once 
permissions are established, viewing calendars 
side-by-side is as simple as clicking the checkbox 
next to the calendar name.  

To open another user’s calendar, Click Open a 
Shared Calendar. To share your calendar with 
others, click Share My Calendar and assign 
permissions. 

QUICK FLAGS – A QUICK ORGANIZER 
Through a study of Outlook users, Microsoft found 
that most people do one of three things with nearly 
every e-mail message: 

1. They respond to it immediately 
2. They delete or file it immediately  
3. They decide to follow-up on it later 

There are almost as many approaches to No. 3 as 
there are users: Mark the message as unread, move 
it to a mail folder called To Do, make a task out of 
it, rigorously delete or file all messages that don’t 
require a response, etc. Each one of these is 

inefficient and takes a lot of extra time, even 
though each strategy may work for a particular 
user.  

Quick Flags are designed to solve this problem. 
Activated by a single click, Quick Flags are very 
simple to use.  

Users single-click the flag icon next to any e-mail 
message in any folder in Outlook, to mark it with 
one of the six Quick Flag options and move on with 
what they were doing, minimizing the disruption of 
managing e-mail. Each marked message gets a 
brightly colored flag next to it so that it is easy to 
find again. 

If you want to create a rule 
based on a message, right-click 
the message on which you 
want to base a rule, and then 
click Create Rule. 

Quick Tip 
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Un-solicited or junk e-mail continues to be a 
growing problem for many companies.  

Spammers often use special techniques designed 
to collect e-mail addresses from newsgroups, 
mailing lists and other programs. It is strongly 
recommended that users not use their corporate 
e-mail address on the Internet to sign up for 
personal newsgroups, e-mail subscriptions, 
contests, etc. You should use a personal e-mail 
account (msn.com, hotmail.com, or other ISP) 
for Internet-related tasks.  

TIPS TO PREVENT UNSOLICITED E-MAIL 
1. Never use your corporate e-mail address  

to enter online contests. 
2. Do not publicize your organization’s 

internal Distribution List aliases on the 
Internet or in newsgroups. 

3. Do not use your corporate e-mail account 
to purchase anything from unsolicited      
e-mail. 

4. Never reply to unsolicited e-mail. 
5. Never “unsubscribe” to unsolicited           

e-mail.  

BLOCK UNSOLICITED E-MAIL AT THE 
INTERNET GATEWAY 
Many organizations have implemented a server-
based solution to restrict the entry of  
unsolicited e-mail in its messaging environment. 
Junk e-mail puts a significant burden on e-mail 
relays, Simple Mail Transport Protocol (SMTP) 
gateways and internal e-mail servers. It also 
impacts end-user productivity by forcing people 
to view unnecessary and sometimes offensive  
e-mail.  

Note: Your organization may have implemented 

a unsolicited e-mail management solution. Its 
intent is to eliminate junk e-mail at your 
organization’s Internet gateway servers. Follow 
the instructions of your organization’s e-mail 
system administrators to ensure that 
unsolicited e-mail is blocked effectively for 
your organization.  

It is important to note that no anti-junk e-mail 
solution is 100% effective; therefore some junk 
e-mail may continue to be delivered to your 
mailbox.  

MANAGE JUNK E-MAIL WITH OUTLOOK 2003 
Outlook 2003 ships with an enhanced Junk E-
mail filter which is designed to assist users with 
processing the unsolicited e-mail that does get 
delivered to their mailbox. 

Each time the Junk E-mail filter detects 
unsolicited e-mail, it remembers the source. It 
can then use that information for future  junk  
e-mail filtering. Users can also teach the filter 
by entering e-mail accounts, aliases, and 
domains into the Trusted Sender list.  

Unwanted domains and unwanted senders can 
also be easily added to the junk senders list 
with a few simple mouse clicks.  

Note: The new Junk E-mail filter is only 
available while using cached Exchange mode. 
(See page #1 for information on cached 
Exchange mode to indicate that junk e-mail 
filtering will work in other configurations, such 
as POP3, Hotmail, and IMAP.) 

FALSE POSITIVES  
Occasionally, the Outlook 2003 Junk E-mail 
filter might incorrectly classify a message 
as junk and move it to the Junk E-mail folder. It 

is important to check the Junk E-mail folder 
regularly to ensure legitimate e-mail has not 
been routed there by mistake. If you do find 
legitimate e-mail in this folder simply highlight 
the e-mail, right click, select Junk E-mail from 
the menu and choose the appropriate action. 

TRUSTED SENDERS 

The Trusted Senders tab allows you to 
specifically add senders that you trust not to be 
spammers. All messages from those listed will 
be delivered directly to your Inbox. The Also 
trust e-mail from my Contacts is checked by 
default. This automatically adds the e-mail 
addresses of your contacts to this trusted list.  

The Junk E-mail Filter in Outlook 2003 can help 
you set different levels of protection to reduce 
the amount of unsolicited email you receive. 

 

Meeting Workspaces (MWS) are secure, 
customizable online locations for 
organizing, sharing and archiving 

meeting-related communications and 
documents. MWS’s are ideal for all teams (local 
and global) that regularly schedule meetings 
and need to create agendas, share information, 
as well as track and follow up on action items. 

MWS’s are customizable sites that are secure 
online locations for organizing, sharing and 
archiving meeting-related communications and 
documents.  

Note: The capability to create a Meeting 
Workspace is implemented by your 
organization’s IT department using the Windows 
SharePoint™ Services feature of Microsoft 
Windows Server™ 2003. Check with your system 
administrator to see if this capability is 
available for your organization. 

SETTING UP THE MEETING WORKSPACE 

A MWS can be set up easily using Outlook 2003’s 
Meeting Request capability. Click on File, New 
Meeting Request or from the Calendar, select 

Actions, New Meeting Request. Add the 
attendees to the meeting request (their names, 
permissions and attendance status will be 
automatically added to and updated on the MWS 
site once you send the meeting request).  

Once you have added the Subject, Time and 
Location to the Meeting Request, click on the 
MWS button and a MWS task pane is displayed on 
the right side of the panel. Click Create in the 
pane on the right to create your MWS.  

Once you have created a MWS, you will have a 
hyperlink on the meeting invitation to navigate 
to the new MWS. Click Change Settings to 
modify the default MWS.  

RECEIVING A MEETING INVITATION 

The meeting invitation for a MWS looks just like 
any other meeting invitation in your Outlook 
Inbox. When you open your meeting invitation, 
you will notice a banner on the body of the 
invitation. To access the MWS, click the 
hyperlink in the banner. When a meeting with 
an associated MWS is placed on your calendar, 
you will notice an “M” icon in that item.  

REPLYING TO THE MEETING INVITATION  
When you send a reply to a meeting invitation 
(accept, decline or tentative), the status of your 
reply will be noted on both your Outlook 
Calendar and within the MWS. If you update 
your attendance status in your calendar, it will 
be reflected on the MWS.  
FORWARDING A MEETING INVITATION 
If you forward an invitation, the new attendee 
will not have access to the MWS unless you are 
the organizer/administrator. The site admini-
strator must add the new person’s alias to the 
site membership list for them to access the site.  

CALENDAR AND MEETINGS 
When you are sent a meeting invitation, if 
you select the Don’t send a response option, 
the meeting organizer is NOT able to view or 
track your response status. It is recommended 
that you select the Send a response now 
option to assure you have accurately commu-
nicated your attendance status. 

Quick Tip 
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MOBILE MESSAGING:  OWA, RPC over HTTP, OMA, and EAS  
Wherever you are in the world, your organization’s mailbox is as close as 
the nearest Internet connection. By using Microsoft Exchange Server 2003 
your organization can offer users secure access to their corporate mailbox 
from any World Wide Web connection via Outlook Web Access (OWA), via 
Outlook 2003 using Remote Procedure Calls (RPC) over HTTP, or virtually 
any browser based mobile device via Outlook Mobile Access (OMA) and 
Exchange ActiveSync (EAS). 

Note: Check with your  organization’s e-mail system administrator to see 
what types of mobile messaging are available within your organization. 

Microsoft Office Outlook Web Access (OWA) enables users to access their 
Exchange Server-based e-mail, calendar, contacts, tasks, and public 
folders through the Internet or an intranet with only a Web browser. 

OWA is a full-featured e-mail application that provides a graphical user 
interface experience similar to Outlook 2003.  

ACCESS TO YOUR E-MAIL THROUGH OWA URLs 
If your organization has enabled OWA, you can access your corporate e-
mail wherever you are in the world so long as you have access to the 
World Wide Web. Using the access URL associated with your region or 
domain ensures that you are getting the best possible OWA performance. 
Even when traveling outside your home region, your regional URL provides 
the best performance.  

Note: Check with your organization’s e-mail administrator to see if this 
option is available for you and for the appropriate URL for you to use. 
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VIEW ADDITIONAL MAILBOXES 
You can open any additional mailbox that has your e-mail profile has 
access to. Once these steps are complete you will find the additional 
mailbox in the folder view along with the original mailbox. 

1. In Outlook, select E-mail Accounts from the Tools menu. 
2. Under E-mail, select View or change existing e-mail accounts, 

and then click Next. 
3. Click Change, then More Settings. 
4. On the Advanced tab click Add.  
5. In the Add Mailbox dialog, type the alias for the mailbox to be 

added and click OK. 

Quick Tip 

RPC over HTTP is a new feature in Outlook 2003 and Exchange 2003 that 
enables mobile and home users to use Outlook to access organization  
e-mail over an Internet connection without needing a virtual private 
network (VPN) to access the rest of the network. Since Outlook is now 
“Internet aware”, it will seem like you are connected directly to your 
organization’s Exchange Server. If you can browse the Web, you can use 
RPC over HTTP with complete Outlook functionality.  

  Note: Check with your organization’s e-mail administrator to see if this    
  option is available and for the appropriate URL for you to use. 

KEY BENEFITS OF USING RPC OVER HTTP 
Simple to install: Determine if your organization has created a script that 
modifies your Outlook client configuration. If yes, install it per instruc-
tions from your e-mail administrator; your Outlook 2003 default profile 
will connect to your Exchange Server with any Internet connection. 

Quickly connect to your Exchange 2003 Server over the Internet: By 
using the HTTP Internet protocol, Outlook 2003 users will be able to 
quickly connect to their Exchange servers and across network firewalls. 

Secure connection: RPC over HTTP uses existing security authentication. 
Network traffic is further encrypted with Secure Socket Language (SSL). 
This is the same protocol used by banks for online banking. 

Note: Check with your organization’s e-mail administrator to see if this 
option is available and for the proper installation and usage instructions. 

Outlook Mobile Access (OMA) and Exchange ActiveSync (EAS) offer users 
real-time access and synchronization to corporate e-mail from any sup-
ported mobile device with Internet or Wireless LAN access, at any time, 
from anywhere.  

• Use OMA to browse your mailbox via your mobile device.  

• Use EAS to synchronize your Windows mobile device with your 
mailbox. After synchronization, you can work offline.  

OMA and EAS are fully integrated features of Exchange Server 2003.  

Note: Check with your organization’s e-mail administrator to see if this 
option is available and for the proper installation and usage instructions. 

METHODS FOR ACCESSING E-MAIL VIA THE INTERNET 
High-speed Internet connection at home, like DSL or cable: Outlook 
2003 can detect your home connection and automatically connect to the 
appropriate Exchange Server within your organization. 

Laptop connected to a customer network: If this network is connected 
to the Internet, but a firewall prevents you from creating a connection 
to your organization’s network, Outlook 2003 can now route data 
through that firewall if RPC over HTTP is installed. Simply open Outlook 
2003 and use it normally. 

Outlook via the Internet (RPC over HTTP)  

Outlook Web Access (OWA) 

Outlook Mobile Access and Exchange ActiveSync (OMA and EAS) 

RECOVER DELETED E-MAILS 
If you find that you deleted an e-mail by mistake there is a way to 
recover those e-mail items up to three days after deletion, even if 
you empty your deleted items folder upon exit. 

1. Open the deleted items folder. 

2. Select Recover Deleted Items from the Tools menu. 

3. Search for e-mails deleted by mistake and highlight. 

4. Click the Recover Selected Items icon. 

Quick Tip 



 

Document Workspaces (DWS) are secure, 
customizable online locations for 
organizing, sharing and archiving 
documents and team information.  

DWS’s facilitate team participation in discussions, 
shared document collaboration, shared tasks, 
events, and surveys. Site content is accessible 
from both Web browsers and through clients that 
support Web Services. The document 
collaboration features allow for easy check-in, 
check-out and document version control.  

Note: The capability to create a DWS is 
implemented by your organization’s IT 
department using the Windows SharePoint 
Services feature of Microsoft Windows Server 
2003. Check with your system administrator to 
see if this capability is available for your use. 

SETTING UP THE DCOUMENT WORKSPACE 

When users of Microsoft Office Outlook 2003 
attach an Office 2003 document to an e-mail 
message, the Attachment Option task pane 
becomes visible. By default, the attachment will 
be sent in the same way as in the previous 
versions of Outlook.  

However, if users select Shared Attachment and 
sends the message, the document will be stored 
on a DWS site that is created automatically on an 
available server running Windows SharePoint 
Services. If users wish, they can specify the 
SharePoint site on which to create the document 

workspace or use the default setting. 

The recipient receives the e-mail containing the 
link to the DWS and can open the document from 
within Outlook and begin to collaborate. 

Likewise, a  DWS can be easily set up by using the 
Shared Workspace capability in any core program 
of Microsoft Office 2003, including Word, Excel, 
PowerPoint, and Visio.  

While in the Office 2003 document, click on 
Tools, Shared Workspaces and a series of task 
panes will open on the right side. Type in the 
name of the document; then, click on the Create 
button. You will be requested to Save the 
document. Once you do this, the DWS will be 
created automatically. You have the option to 
specify the intranet URL for the DWS or use the 

default URL set up by your organization’s 
administrator. 

Whether initiated within Outlook or other Office 
2003 programs, sharing attachments 
automatically provides all of the collaborative 
workflow and information functionality found in a 
DWS. This information also appears in context 
directly in the Shared Workspace task pane beside 
the document whenever it is opened on a team 
member’s PC. Recipients of the e-mail message 
are automatically added to the workspace.  

INVITING WORKSPACE MEMBERS 
DWS can be linked to your organization’s e-mail 
address book making it easy to invite new 
members or to create groups. If your organization 
has implemented “presence”— the ability to see 
who in your group is online — then you can see at 
a glance who is available to respond and review 
your document. 

WORKSPACE ADMINISTRATION 
The sender (i.e. the creator) of the document 
becomes the site administrator of the DWS. All of 
the recipients become members of the DWS 
where they are granted permission to contribute 
to the site. 

The administrator can invite other members to 
the DWS, assign permissions, establish tasks, and 
manage the DWS according to the rules 
established by your organization’s administrator. 
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Category Online Location  

Microsoft Office Outlook 2003 http://www.microsoft.com/office  

Microsoft Exchange Server 2003 http://www.microsoft.com/exchange   

Microsoft Information Rights Management—
Windows Server 2003 

http://www.microsoft.com/windowsserver2003/technologies/rightsmgmt/default.mspx   

Microsoft Information Rights Management— 
Office 2003 

http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/office/
Office2003/Plan/Of03IRM.asp 

 

Microsoft Document and Meeting Workspaces http://www.microsoft.com/windowsserver2003/technologies/sharepoint/default.mspx    

Microsoft Anti-Spam Capabilities— 
Exchange Server 2003  

http://www.microsoft.com/exchange/techinfo/security/antispam.asp  

[Organization] Outlook Web Access URL https://xxx.xxx.xxx [To be completed by organization]  

[Organization] Outlook Mobile Access URL https://xxx.xxx.xxx [To be completed by organization]  


